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Introduction

This document highlights the differences between XyWrite 4.0 and earlier 
versions of XyWrite. It does not cover all the enhancements to all the 
commands, but instead summarizes the major changes. We recommend 
that you read the XyWrite 4.0 manuals, particularly the Command Reference 
Guide, to get a full understanding of XyWrite 4.0's capabilities.

If you are upgrading to XyWrite 4.0 from Signature, refer to the Appendix 
for a summary of product changes.

NOTE The description of most features includes a reference to one of the manuals 
that you received with XyWrite 4.0. For more information about new or 
modified features, read the pages listed. I&L refers to the Installation and 
Learning Guide. CRG refers to the Command Reference Guide; CG refers to 
the Customization Guide.
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User Interface

Introduction
One of the major changes to XyWrite is an improved interface. The 
following paragraphs summarize the changes that affect the way you use 
XyWrite.

MENUS
In addition to the command line, which you still access by pressing [Fsl. 
XyWrite includes a pull-down menu interface, which you access by 
pressing [n^. The menus give you an alternative way to issue standard 
commands; they also include functions not available from the command 
line (such as Log and Restore Session and Bookmarks). The Installation and 
Learning Guide is your introduction to the menus; more detailed 
information is available from the on-line help program.

NOTE We recommend that you load the menu files (XY4.MNU and XY4.DLG) 
even if you don't expect to use them. Several features, including many of 
the keyboard shortcuts, rely on the menus.

Graphic view
Graphic view is an editable WYSIWYG (what-you-see-is-what-you-get) 
view of your documents (CRG, page 4-7). (Press iShiftlfFtfl to activate 
graphic view.)

MOUSE
XyWrite supports a 2- or 3-button mouse (CRG, page 3-16).

KEYBOARD
The standard XyWrite 4.0 keyboard (XY4.KBD) follows the CUA 
(Common User Access) design specification. This specification encourages 
consistency among software products so that users can more easily switch 
from one program to another. CUA recommends that standard functions, 
like help, be assigned to the same key in all products, that cursor 
movement keys function in the same way in all programs, etc.
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User Interface

When you installed XyWrite, you were given the option of selecting a 
CUA setup or a XyWrite III Plus style setup. If you chose the CUA setup, 
you will notice changes in the keyboard layout. For example, [fT] displays 
on-line help rather than selecting text. Many of the standard keys, like [F5] 
and [F9] remain the same, but you will need to spend some time reviewing 
the keyboard descriptions in Chapter 3 of the Command Reference Guide to 
learn the CUA key assignments.

If you chose the XyWrite III Plus style setup, an alternative keyboard- 
XY4-3.KBD—is automatically loaded for you. This keyboard uses the 
familiar key assignments you learned with earlier versions of XyWrite. It 
also incorporates many of the keyboard shortcuts introduced in XyWrite 
4.0. Keep in mind that the documentation, except for the template, 
describes the CUA-style keyboard, and some keyboard shortcuts may not 
be available in the XyWrite III Plus style keyboard.

NOTE Both keyboard files are installed in your XyWrite 4.0 directory. You can 
use the LOAD command at any time to install the alternative keyboard 
file. You can also load a customized keyboard file if you have one.

DEFAULT SETTINGS
Default settings control many aspects of XyWrite, from the screen 
appearance to page format. When you first start XyWrite, it provides you 
with a set of defaults. Many of the initial defaults are based on choices 
you made during installation, which means that your setup is customized 
to your hardware configuration and personal preferences.

It also means that this document can't describe the "standard setup" 
because there is no standard. To get acquainted with the defaults in effect 
on your computer, read the file SETTINGS.DFL which is in the main 
XyWrite directory.

Remember that it is simple to change a default setting, either for the 
current editing session or more permanently. For more information, refer 
to the Defaults section of the Customization Guide.
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New Commands and Features

Introduction
This section describes new commands and features. It is organized along 
the same lines as the Command Reference Guide (CRG) and Customization 
Guide (CG).

FILING COMMANDS
LOGON AND LOGOFF (CRG, page 2-39)
The LOGON command identifies you to the program, and the LOGOFF 
command signs you off of XyWrite. Logon names are used by the 
Document Info and Redlining features. In network installations, logon 
names facilitate the storage of settings for individual users.

LOG AND RESTORE SESSION (CRG, pages 2-34 and 2-62)
When you quit XyWrite (or at any time during the XyWrite session), you 
can capture the status of your work so you can return to it later.

EXPANDED MEMORY (CRG, pages 2-33 and 2-34)
XyWrite automatically uses up to 4MB of expanded memory. You can 
increase or decrease the amount of expanded memory in use by 
appending the /E switch to the EDITOR command.

DOCUMENT INFORMATION
The optional Document Info feature automatically generates summary 
information about every file you create. You use the menus (File, 
Document Info) to display the information.

FILE ATTRIBUTE (CRG, page 2-9)
The ATTRIB command lets you determine or change the status of a file's 
read-only attribute.

APPEND TO TOP (CRG, page 2-8)
The APT command adds text to the top of the file.

FINDING FILES (CRG, pages 2-34 and 2-62)
The FINDL command displays a directory of all occurrences of the 
specified file plus the first few lines of text from each file.
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New Commands and Features

PRINT QUEUE STATUS
The Manage Jobs option on the File menu lets you monitor and change the 
status of files waiting to be printed.

READ FILES (CRG, page 2-63)
The READ command displays files for reading only. (This command was 
available in the LAN version of XyWrite III Plus.)

DCA CONVERSION (CRG, page 2-72)
The X2R and R2X commands convert XyWrite files to RFT:DCA format 
and RFT:DCA files into XyWrite format, respectively.

FILE CONVERSION
The File menu includes options to convert files from other word processor 
formats to XyWrite 4.0 format or to save XyWrite 4.0 files in other formats. 
(Choose File, Open, Options to convert files to XyWrite format; choose 
File, Save As to convert files from XyWrite format.)

EDITING COMMANDS
TRANSPOSE TEXT (CRG, page 3-32)
You can transpose characters, words, sentences, or paragraphs with a 
single keystroke combination. (Press the tilde key and C, W, S, or P or 
tilde and 1,2, 3, or 4 to transpose characters, words, sentences, or 
paragraphs, respectively.)

COMMAND STACK (CRG, page 3-8)
XyWrite keeps track of recently executed commands so you can recall an 
earlier command without retyping it. (Move to the command line and 
press SB to USe the command stack.)

CHANGE CASE (CRG, page 3-34)
There are two keyboard shortcuts for the Change Case (CC) command: 
[CtrilX and gH. In addition to changing case of the current letter, fetrilH 
cycles through the CC, LC, CF, and UC functions when text is selected.
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New Commands and Features

UNDELETE STACK (CRG, page 3-30)
The undelete stack allows you to retrieve recently deleted text either a unit 
at a time or as a block. (Press [F12] to display the undelete stack.)

CLIPBOARD and MEMO PAD
The clipboard is a temporary storage area for text you want to paste in a 
different part of your document (or in a different document altogether). 
The memo pad is a file you can use for text you need access to quickly, 
without using the Call command or going through the Open File dialog 
box. The Clipboard is part of the Edit menu; the Memo Pad is an option of 
the Advanced menu.

PROTECTING TEXT (CRG, page 3-27)
The NM command lets you mark a block of text you do not want 
modified.

FORMATTING COMMANDS
MEASUREMENT UNITS (CRG, page 4-8)
Formatting commands specifying horizontal or vertical values accept units 
of measure.

ZOOM COMMAND (CRG, page 4-12)
The ZOOM command lets you enlarge or reduce the graphic view of a 
page.

GRAPHIC DESIGN COMMANDS (CRG, page 4-51)
Graphic design commands allow you to create wrap-around text and add 
borders to your documents. The graphic design commands include FA 
(Frame Area), BO (Border) and BOX (Line Draw).

IMPORT FILES (CRG, page 4-75)
XyWrite gives you the ability to import files from other software 
programs, including graphics, spreadsheets, database records, even text 
generated on other word processor programs. The import commands 
include IG (Import Graphic) and LINKTX (Link Text).
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New Commands and Features

LINE NUMBERING (CRG, page 4-104)
The LN (Line Numbering) command enables you to print the number of 
each line of text in the margin.

LINE JUSTIFICATION (CRG, page 4-14)
The LJ (Line Justify) command lets you control the alignment of the cur
rent line.

BLANK LINES (CRG, page 4-135)
The BL (Blank Lines) command lets you print or suppress the printing of 
blank lines at the top of a page or column.

PAGE WIDTH (CRG, page 143)
The PW (Page Width) command establishes the width of the sheet of 
paper you print on.

ELEMENT TOP, ELEMENT END
The ET (Element Top) and EE (Element End) command create a vertical 
offset.

GUTTER (CRG, page 4-142)
The GU (Gutter) command inserts white space on the left and right sides 
of pages, columns, cells, and frames.

PRINTER CONTROL COMMANDS (CRG, 4-153)
Several new commands give you added ability to request special features 
from your printer. The new commands include: OS (One-Sided Format); 
DY (Print in Color); EF (Special Effects); LQ (Letter Quality); and OR 
(Orientation).

TYPE STYLE COMMANDS (CRG, 4-169)
The SZ (Size) command allows you to change the type size of text; the UF 
(Use Font) command allows you to change the typeface in which your text 
is printed; the SY (Symbol Set) command allows you to specify the symbol 
set you want (for Hewlett Packard LaserJet printers only); and the LA 
command allows you to specify the code page used to create the 
document.
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New Commands and Features

Special features
DOCUMENT ASSEMBLY (CRG, 5-17)
The Document Assembly feature allows you to build customized 
documents using standard paragraphs (boilerplate) from other 
documents.

COLUMNS (CRG, page 5-13)
Two new commands enhance the columns feature: the BC (Break Column) 
command causes text that follows to advance to the top of the next 
column; the SH (Snake Height) command allows you to set the depth for 
snaked columns to be less than the standard text length.

NOTE Previous versions of XyWrite used PG commands to break columns. In 
XyWrite 4.0, a PG command forces a column to a new page.

TABLES
The Tables option on the Insert menu offers several new table editing 
functions.

MAIL MERGE (CRG, page 5^49)
The Mail Merge feature allows you to embed conditional and 
mathematical instructions that you want executed before or during the 
merge.

RECORD KEYSTROKE MODE (CRC, 5-88)
The Record Keystroke mode saves keystrokes so you can play them back 
again and again. (Press to turn Record Keystroke mode on and off.)

SORT DATA FILE
The SORTD (Sort Data File) command allows you to select and rearrange 
the entries in a data file according to the rules you establish.
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New Commands and Features

Customization commands
COMMAND OVERRIDE (CG, page 1)
The Command Override feature lets you create your own commands or 
redefine XyWrite's commands and function calls. A sample set of 
customized commands, called SAMPLE.SET, is automatically delivered 
with Xy Write.

DEFAULTS (CG, page 6)
XyWrite uses a default file called SETTINGS.DFL that is generated during 
installation. You can edit this file to customize XyWrite to your needs.
A large number of default settings have been added to XyWrite. A 
complete list is included in the Customization Guide.

LOADING PRINTER FILE INFORMATION (CG, page 84)
The SETP command lets you select the print destination you want to use 
and automatically loads the associated printer file.
The CART (Cartridge) command loads into memory font information 
about the specified cartridge fonts.

CUSTOMIZATION FILES (CG, pages 82 and 91)
XyWrite supports eleven types of customization files, including a menu 
file and dialog box file.

USER PROGRAMMING (CG, page 199)
Enhancements to the XyWrite Programming Language (XPL) include: a 
new function call (BX) that executes a command from within a program 
without moving the cursor to the command line; the ability to add 
comments to programs; a debugging tool; and more macros. Refer to the 
Customization Guide for more information.

VARIABLES (CG, page 224)
Approximately 100 new VA settings are available. Refer to the 
Customization Guide for a complete list.

KEYBOARD DIAGNOSTICS (CG, page A-2)
A keyboard diagnostic tool helps you customize keyboard files.
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Modified Commands and Features

Introduction
This section describes general changes to features that existed in earlier 
versions of XyWrite. Again, the emphasis is on major changes to existing 
features— changes that cause the features to work differently than you 
expect. You should review the Command Reference Guide to learn about all 
the command enhancements.

As in the previous sections, the descriptions are organized along the same 
lines as the Command Reference Guide.

Filing Commands
PRINTING DISPLAYED FILES (CRG, page 2-54)
In previous versions, a file named PRINT.TMP was created every time you 
printed a displayed file. This file remained on disk until it was overwritten 
or until you manually deleted it. In XyWrite 4.0, printing a displayed file 
creates a randomly named temporary file that is automatically deleted 
when printing is complete.

CM COMMAND
CM is now an obsolete command because the current drive, path, and 
window number are always displayed on the command line.

DIRECTORY COMMAND (CRG, page 2-20)
Enhancements to the DIR (Directory) command include the support of 
wildcards and the addition of several command modifiers.

EDITING COMMANDS
ESC Key
In previous versions, pressing the [Esc] key inserted an escape code in your 
file. In XyWrite 4.0, pressing [Esc] performs the escape function-deselects 
text, exits the command line, resets prevailing mode, cancels help, moves 
up one menu level; etc. Press 1 Shift| [Esc] to insert the escape character (which 
is represented by <r).
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Modified Commands and Features

SPELLING CHECKER (CRG, pages 3-82,3-84,3-86)
Depending on what version of XyWrite you are upgrading from, you'll 
find some new functions or notice the return of some old favorites.
Xy Write 4.0 restores the Auto-Correct and Auto-Replace features removed 
from XyWrite III Plus because of the threat of patent infringement.

SEARCH COMMANDS (CRG, page 3-54)
The Search commands support additional wildcards as well as several 
new command modifiers. The Change commands accept wildcards on 
both sides of the command argument.

FORMATTING COMMANDS
SELECTED TEXT (CRG, page 4-7)
Many formatting commands can be applied to selected text, as long as the 
cursor is in or immediately to the right of the selection.

TYPE STYLES (CRG, page 4-170)
You can use additive modes to create relative styles (modes) by adding or 
subtracting a type style.

FOOTNOTES (CRG, pages 4-41 and 4-49)
The BF (Bottom Footnote) command is no longer part of the FM (Footnote 
Format) command; it is now a separate command. The format of the SC 
(Superscript) argument to the FM command has been modified to accept 
the label (NM, BO, SC, etc.) for the mode you want to use.

FOOTERS (CRG, page 4-72)
In XyWrite III Plus, the RF (Running Footer) command took effect on the 
current page. In XyWrite 4.0, it takes effect on the current page only if it is 
on the first line of the page, ahead of any text, returns, or spaces; other
wise, it takes effect on the next page.

PAGE LAYOUT
To simplify the process of formatting pages, several XyWrite commands 
have been modified. As a result of these changes, as well as the new
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default settings, existing files may be formatted differently. The following 
paragraphs highlight the differences. Refer to Chapter 4 of the Command 
Reference Guide for complete command descriptions.

CAUTION Earlier versions of XyWrite set most formatting defaults to 0. In XyWrite 
4.0, values are automatically established for the page formatting 
commands, enabling you to print an attractive 8-1/2 x 11 inch page of text 
without entering a single command. Commands embedded in files 
always override default values. However, you may encounter a problem 
with existing XyWrite files if they don't explicitly override a default 
command with an embedded command.

A common example of this potential problem is created by the interaction 
of the LM and OF commands. In XyWrite 4.0, the default value for OF is 
HN,1IN. If your documents have an embedded LM command, the value of 
the left offset (established by the OF default) and the left margin 
(established by the LM embedded command) will be added, giving you a 
wider left margin than you want. To correct the problem, you can (1) 
change the value of the OF default; (2) embed an OF command at the 
beginning of the document to override the default; or (3) remove the LM 
command from the document.

Top Margin. The TP (Top Margin) command now has two arguments; the 
first argument defines the distance between the top of the page and the 
running header and the second argument defines the distance between the 
top of the page and the body text. (CRG, page 4-124)

Bottom Margin. The BT (Bottom Margin) command now has four argu
ments: foot, nom, min, max. It performs functions previously associated 
with the PL (Page Length) command. (CRG, page 4-125)

NOTE The PL command is still supported, but we recommend that you use the 
BT command when formatting new documents. If both the BT and PL 
commands are used in the same document, the one that is embedded last 
overrides the earlier one. (The menus use the BT command exclusively.)
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i

Offset The OF (Offset) command establishes the left and right margins 
for documents, performing the functions previously associated with the 
LM (Left Margin) and RM (Right Margin) commands. By default, the 
document margins established by the OF command are 1 inch on both the 
left and right.

You cannot change the OF command in the middle of a page. (CRG, page 
4-140)

NOTE LM and RM commands are still supported, but we recommend that you 
use the OF command to establish overall document margins, and use LM 
and RM for other purposes. For example, if you want to change the left 
margin in the middle of a page, you could use the LM command. And if 
you are trying to establish a particular text width (to fit the width of a 
business card design, for example), you may prefer to use the RM 
command. (CRG, page 4-139)

Indent Paragraph. The IP (Indent Paragraph) command has a third 
argument that specifies the indent from the right edge of the page. We 
recommend that you use the indent command to change margins within a 
document. (CRG, page 4-144)

BREAKING PAGES (CRG, pages 4-129 and 4-131)
The PG (Page Break) command offers another conditional option; you can 
specify that you want the page to break only if the command falls on an 
odd page or on an even page.

The NB (No Break) command can be applied to selected text or to a 
specified number of lines.

In earlier versions of XyWrite, you used the PG command to break text 
between snaked columns. A new command, BC, is now used to break 
columns of text. If you have existing documents that use PG commands 
between columns, replace the PG commands with BC commands.

CAUTION
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STYLES (CRG, page 4-163)
The SS (Save Style) command accepts text or formatting commands you 
want inserted when you issue a US (Use Style) command. The US (Use 
Style) command accepts relative values.

TAB SETTINGS (CRG, page 4-147)
The tab and margin selection menu previously built into XyWrite is 
obsolete. Instead, use the dialog boxes provided by the menus. (Choose 
Format, Indents/Tabs or Format, Page Margins from the menu.)

E

Special Features
COLUMNS AND TABLES (CRG, page 5-3)
You can create up to 12 columns with the SN (Snake Columns) or CT 
(Create Table) commands.

MAIL MERGE (CRG, page 5-33)
Depending on the choices you made during installation, the field and 
record separators may be a tab and carriage return, respectively, rather 
than a carriage return and two carriage returns. Refer to the definitions of 
the FX and RS settings in SETTINGS.DFL to verify the current default 
values. If your existing data files use separators other than those currently 
established by default, you can change defaults easily, as described in the 
Customization Guide.

USER PROGRAMMING (CRG, page 5-97 and CG, page 199)
Most of your XPL programs will run without a problem, but there are 
some exceptions. The following paragraphs describe some of the things 
that may affect the way existing XPL programs operate:
• Changes to the keyboard may affect XPL programs that trap for

specific keys. For example, if a program looks for the escape character 
to terminate a routine, you may want to change the escape character to 
the ES function call.

I
1

• The operating environment for your programs may have changed 
because of new or different default settings. For example, the EP (Error
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Prompt) default causes XyWrite to display a verification message when 
you issue a DELETE command. If you have a program that executes a 
DELETE command and have EP on, the program may not run as it did 
in earlier versions of XyWrite. You need to be aware of the default 
settings in effect and their impact on your programs. Refer to the 
Customization Guide for detailed information on defaults.

• Some commands and function calls have been modified, and these
changes will have an impact on your programs. For example:
- The QUIT command in XyWrite 4.0 stops at each open file that has 

been edited and asks if you want to save the changes, abandon 
them, or cancel the QUIT command.

- The RE (Rubout to End of Line) function call now moves the cursor 
to the beginning of the next line if the cursor is at the end of the line. 
In XyWrite III Plus, the cursor remained on the same line.

- The DW (Define Word) function call does not include sentence 
separators, but does include word separators. In XyWrite III Plus, 
the sentence separators were included.

- Some function calls that used to work only in text now function in 
the header. For example, you can now insert text from a macro into 
the header. You may have to add a GT (Go to Text) function call to 
your program to make it work the way you want.

- If you are saving the results of an XS command to a macro, you 
should initialize the macro before executing the XS command in 
order to prevent an error.

PRINTER FILES (CG, page 139)
XyWrite III Plus printer files are fully compatible with XyWrite 4.0. 
However, if you load a XyWrite III Plus printer file, XyWrite 4.0's Type 
Style commands (SZ, UF, SY) and Printer Control commands (OR, DY, LQ, 
EF) will not work, because the code that supports them is not in the older 
printer files. In addition, graphic view, image mode printing, and borders 
will not be available.
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HELP FILES (CG, page 91)
XyWrite III Plus help files are fully compatible with XyWrite 4.0.

KEYBOARD FILES (CG, page 55)
XyWrite III Plus keyboard files are fully compatible with XyWrite 4.0.
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Appendix . Signature Upgrades

Introduction
This appendix highlights the differences between XyWrite 4.0 and 
Signature. Although the transition between Signature and XyWrite should 
be an easy one, we recommend that you read the following pages carefully 
before starting; pay particular attention to the section "Modified 
Commands and Features." Refer to the Command Reference Guide (CRG) 
and the Customization Guide (CG) for complete details.

New Commands and Features
LOG AND RESTORE SESSION (CRG, pages 2-34 and 2-62)
When you quit XyWrite (or at any time during the XyWrite session), you 
can capture the status of your work so you can return to it later.

EXPANDED MEMORY (CRG, pages 2-33 and 2-34)
XyWrite automatically uses up to 4MB of expanded memory. You can 
increase or decrease the amount of expanded memory in use by 
appending the /E switch to the EDITOR command.

TRANSPOSE TEXT (CRG, page 3-32)
You can transpose characters, words, sentences, or paragraphs with a 
single keystroke combination. (Press the tilde key and C, W, S, or P or 
tilde and 1,2, 3, or 4 to transpose characters, words, sentences, or 
paragraphs, respectively.)

CHANGE CASE (CRG, page 3-34)
There are two keyboard shortcuts for the Change Case (CC) command: 
fctrflX and [CtrilH. In addition to changing case of the current letter, [CtrilH 
cycles through the CC, LC, CF, and UC functions when text is selected.

UNDELETE STACK (CRG, page 3-30)
The undelete stack allows you to retrieve recently deleted text either a unit 
at a time or as a block. (Press [R2] to display the undelete stack.)

AUTO-CORRECT and AUTO-REPLACE (CRG, pages 3-82,3-84) 
Auto-Correct corrects misspellings as you type, and Auto-Replace replaces 
abbreviations with the expanded form defined in your personal 
dictionary.
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LINE JUSTIFICATION (CRG, page 4-14)
The LJ (Line Justify) command lets you control the alignment of the cur
rent line.

BLANK LINES (CRG, page 4-135)
The BL (Blank Lines) command lets you print or suppress the printing of 
blank lines at the top of a page or column.

GUTTER (CRG, page 4-142)
The GU (Gutter) command inserts white space on the left and right sides 
of pages, columns, cells, and frames.

ONE-SIDED (CRG, page 4-156)
The OS (One-Sided) command lets you change the format of your 
document temporarily, so only the formatted commands for odd- 
numbered pages are applied.

BREAK COLUMN (CRG, page 5-14)
The BC (Break Column) command causes text that follows to advance to 
the top of the next column.

SNAKE HEIGHT (CRG, page 4-156)
The SH (Snake Height) command allows you to set the depth for snaked 
columns to be less than the standard text length.

LANGUAGE (CRG, page 4-177)
The LA (Language) command allows you to work with files that were 
created in code page 850 and code page 437, no matter what the default 
setting is. (In Signature, the default code page is 850; in XyWrite, the 
default code page is 437.)

COMMAND OVERRIDE (CG, page 1)
The Command Override feature lets you create your own commands or 
redefine XyWrite's commands and function calls. A sample set of 
customized commands, called SAMPLE.SET, is automatically delivered 
with XyWrite.
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DEFAULT SETTINGS
Several new default settings have been added:
• D1 (Delete Stack) defines the number of entries XyWrite keeps in the 

delete stack and the minimum number of characters it recognizes as a 
delete unit (CG, page 18).

• ES (Enable Scoping) specifies the boundaries, or scope, of formatting 
commands (CG, page 22).

• LH (Low-High) specifies the size and baseline for superscript and sub
script characters in the Bitstream Speedo fonts (CG, page 28).

• OD (Offset Display) determines whether XyWrite hides or shows the 
offset specified by the OF command (CG, page 31).

• RZ (Record Size) defines the maximum number of characters XyWrite 
recognizes when sorting data file records (CG, page 34).

• WF (Wrap to Fit) allows you to specify the way line endings are de
termined in draft and expanded views (CG, page 39).

• ZM (Zoom) enlarges or reduces graphic view by the amount you 
specify (CG, page 42).

MODIFIED COMMANDS AND FEATURES
PROGRAM STARTUP (CRG, page 2-33)
In Signature, you start the editing session by typing SIG at the DOS 
prompt. In XyWrite, you start the editing session by typing EDITOR at the 
DOS prompt.

CHARACTER SET (CRG, page 4-177)
In Signature, the first 256 characters in the character set are based on code 
page 850 (the multi-lingual character set). In XyWrite 4.0, the first 256 
characters are based on code page 437 (the United States character set). To 
make your Signature printer files and text files fully compatible with 
XyWrite 4.0, we recommend that you change the LA (Language) setting in 
SETTINGS.DFL from 437 to 850 and then reload SE1T1NGS.DFL. 
Alternatively, you can embed the command LA 850 in your Signature files. 
(In Signature printer files, embed the command as part of the file label 
(;PR«LA850»;).
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SPELLING CHECKER (CRG, page 3-69)
By default, XyWrite 4.0 uses the spelling dictionary and thesaurus 
developed by Microlytics Inc. If you prefer, you can continue to use the 
spelling dictionary and thesaurus that you used with Signature. To 
activate the Signature versions:
1. Copy the four PCLEXAM files (PCLEXAM.DLO through

PCLEXAM.DL3) from the Signature directory to the XY4 directory. 
These files must be in the same location as EDITOR.EXE.

2. Add the following three default commands to SETTINGS.DFL:
DF LX=d:\path 
DF UD=dictionary 
DF OM=0

where d: is the drive and \path is the subdirectory that contains the 
dictionary; and dictionary is the name of the main spelling dictionary. 
The OM=0 default tells XyWrite to honor the other two default settings 
and to use the PCLEXAM files.

NOTE The Signature-based spelling checker is available as an add-on to users 
upgrading from XyWrite. For more information, contact The Technology 
Group.

HYPHENATION (CRG, page 4-18)
XyWrite 4.0 uses a hyphenation algorithm and an optional hyphenation 
dictionary to determine word breaks. Signature uses its main spelling 
dictionary to determine word breaks. If you open a file that was created in 
Signature, the hyphenation points may be different because of the differences 
in the programs' operation.

If you prefer to use the XyWrite 4.0 spelling dictionary but Signature's 
hyphenation, follow the procedure outlined for the activating the 
Signature spelling checker but set the OM default to 15.
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PAGE LAYOUT
To simplify the process of formatting pages, several formatting commands 
have been modified. As a result of these changes, as well as the new 
default settings, existing files may be formatted differently. The following 
paragraphs highlight the differences. Refer to Chapter 4 of the Command 
Reference Guide for complete command descriptions.

Caution In XyWrite 4.0, values are automatically established for the page 
formatting commands, enabling you to print an attractive 8-1/2 x 11 inch 
page of text without entering a single command. Commands embedded 
in files always override default values. However, you may encounter a 
problem with existing Signature files if they don't explicitly override a 
default command with an embedded command.

A common example of this potential problem is created by the interaction 
of the LM and OF commands. In XyWrite 4.0, the default value for OF is 
1IN,1IN. If your documents have an embedded LM command, the value of 
the left offset (established by the OF default) and the left margin 
(established by the LM embedded command) will be added, giving you a 
wider left margin than you want. To correct the problem, you can (1) 
change the value of the OF default; (2) embed an OF command at the 
beginning of the document to override the default; or (3) remove the LM 
command from the document.

Top Margin. The TP (Top Margin) command now has two arguments; the 
first argument defines the distance between the top of the page and the 
running header and the second argument defines the distance between the 
top of the page and the body text. (CRG, page 4-124)

Bottom Margin. The BT (Bottom Margin) command now has four argu
ments: foot, nom, min, max. It performs functions previously associated 
with the PL (Page Length) command. (CRG, page 4-125)

The PL command is still supported, but we recommend that you use the 
BT command when formatting new documents. If both the BT and PL

NOTE
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commands are used in the same document, the one that is embedded last 
overrides the first one.

Offset The OF (Offset) command establishes the left and right margins 
for documents, performing the functions previously associated with the 
LM (Left Margin) and RM (Right Margin) commands. By default, the 
document margins established by the OF command are 1 inch on both the 
left and right.

XyWrite accepts only one OF command per page. (CRG, page 4-140)

NOTE LM and RM commands are still supported, but we recommend that you 
use the OF command to establish overall document margins, and use LM 
and RM for other purposes. For example, if you want to change the left 
margin in the middle of a page, you could use the LM command. And if 
you are trying to establish a particular text width (to fit the width of a 
business card design, for example), you may prefer to use the RM 
command. (CRG, page 4-139)

Indent Paragraph. The IP (Indent Paragraph) command has a third 
argument that specifies the indent from the right edge of the page. We 
recommend that you use the indent command to change margins within a 
document. (CRG, page 4-144)

BREAKING PAGES (CRG, pages 4-129 and 4-131)
The PG (Page Break) command offers another conditional option; you can 
specify that you want the page to break only if the command falls on an 
odd page or on an even page.

The NB (No Break) command can be applied to selected text or to a 
specified number of lines.

CAUTION With Signature, you use the PG command to break text between snaked 
columns. A new command, BC, is now used to break columns of text. If 
you have existing documents that use PG commands between columns, 
replace the PG commands with BC commands.
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PROGRAMMING
VA $DI returns different values than it did in Signature, which means 
existing SPL programs that use this VA may not work the same way. 
Refer to the Customization Guide for information on how VA $DI now 
works.
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